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1 Introduction 
This document covers the operation of the ezPyroTM Evaluation Tool software and should be used in conjunction with 

the ezPyroTM Sensor Reference Manual. 

The software can be used to test up to four single-pixel sensors or one 2x2 array sensor. It enables you to optimise the 

sensor for a specific environment, observe signals in real time, and to experiment with register settings, optimising: 

 Gain 

 Filtering (HPF, LPF, Transconductance) 

 Sample rate 

 clk/sync for device synchronisation 

 Interrupt enable / disable 

 Wake Up (WUP) 

Register settings can be saved to, and loaded from, a text file. Please refer to page 21 for details. 

Please note: this software is generic and can be used with any of the digital evaluation kits and development boards in 

this range. However, the evaluation kits also have type specific software which allows for a more in-depth analysis of 

the element that each kit has been developed for. 

2 Getting Started 

2.1 Installing ezPyroTM Evaluation Tool 

To install the ezPyroTM Evaluation Tool from the ezPyroTM Software folder on the supplied USB stick, open the ezPyroTM 

Evaluation Tool folder and run the setup application. The software is compatible with Windows 7, 8, & 10. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: Evaluation Tool Install Shield Wizard 
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2.2 Launching the Software 

1. Open the ezPyroTM Evaluation Tool from the Start menu of the connected computer. By default, the software 

launches in the 4-sensor single-pixel view. If a device has been connected before launching the software, go to 

step 4. 

Figure 2: Multiple Single-Pixel Sensor View (Default) without a connected device 

2. Connect the device to the PC. 

3. The name of the device appears in the Device menu. Click on the device to complete the connection. 

 

 

 

 

 

 

 

Figure 3: Connect to device 

 

4. If no device appears in the list, or the device is plugged in after the software is opened, select Rescan Ports from 

the Device menu.  

 

 

 

Figure 4: Connected to device 
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5. A warning message “Master device has no channels enabled” is displayed. This implies no data will be streaming 

as the clk and sync outputs of the master will be inactive when no data is being recorded. No data will be streamed 

until the channels have been enabled on the master (by default, Sensor 1 is the master, but this can be changed 

in the AFE register settings). 

Note: This message is not displayed if the sensors have been used previously or if a default configuration file exists. 

 

 

 

 

 

Figure 5: Device Connected - no channels active 

6. Click on the OK button.  

 

Note: There can only be one master device for surface mounted devices. If there is more than one master, then the 

slaves receive multiple clock and sync signals, and this causes interference in the slave output resulting in a noisy signal. 
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3 4-Sensor Single-Pixel View 
With four sensors connected to the backplane board the following window is displayed. 

 

Figure 6: ezPyroTM Evaluation Tool window before sensors have been enabled 

1. Input values as required into the CCP register(s) for the sensor.  

 

Note: These textboxes represent the bits of the registers. The input must be zeroes and ones (binary characters) and 

will be interpreted as a byte regardless of how many characters have been input. For example, 111 is interpreted as 

00000111. Entries are treated as the least significant bits of the whole byte. 

 

When changing registers directly please refer to the sensor reference manual; this explains the meaning of each bit in 

the registers. 
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Figure 7: Changing CCP Register settings directly 

Note: Any change to a register setting is not implemented until the Apply button has been clicked. If a new setting has 

not been applied it is shaded grey, as shown in Figure 7. 

2. Click on the Apply button for the sensor. Check that a signal is displayed. 

 

Figure 8: Changing CCP Register settings directly - No Saturation 
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3.1 Sensor Configuration Settings 

For more detailed information about the CCP, AFE or WUP settings, click on the cogs adjacent to the register settings. 

Changes are not implemented until the Apply button has been clicked. If a modified text field has not been applied, 

the box is shaded grey. 

Note: Please refer to the ezPyroTM Sensor Reference Manual for information about these registers and their settings. 

 

            

 

 

 

 

 

 

 

 

Figure 9: CCP Cog Single-Pixel Sensor view Sensor 1 

 

 

 

 

 

 

 

 

 

 

            

Figure 10: AFE Cog Single-Pixel Sensor view Sensor 1 
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Figure 11: WUP Cog Single-Pixel Sensor view Sensor 1 

3.2 Saturation 

Sometimes when the device is first started it will saturate for a time before it settles. This can take up to 10 seconds 

to stop. Typical saturation events are shown in Figure 12.  If the sensors are uncovered, and the gain and 

transconductance setting are set to maximum, signal saturation due to air flow is likely. 

 

 

 

 

 

 

 

 

 

 

Figure 12: Changing CCP Registers directly – Saturation and Warning message for CSV capture 

If saturation occurs during a csv file writing operation (see insert above), a warning dialog is displayed. Click on the 

Stop Capture button to cancel the recording of data. The dialog also offers the option to suppress the saturation 

warning message in future. 

When a saturation event occurs ‘Saturation Occurred ‘, is added to the file name and the saturated values are changed 

to 65535 in the appropriate data column. This ensures that the event is easy to identify when viewing files. It also 

allows any analysis to be easily accomplished without having to do any pre-processing of the data. 
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3.3 Multiple Sensor Single-Pixel Views 

The ezPyroTM Evaluation Tool detects sensors when the device is connected to the PC and adjusts the display 

accordingly.  

Note: Sensors must be connected in numerical order. For example, if you want to use two sensors ensure they are 

placed in positions 1 and 2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 13: 1 (top), 2 (middle) and 3 (bottom) sensor single-pixel views 
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3.4 Programming Modes 

By default, Single Device programming mode is selected. In this mode the settings for all sensors can be set 

independently. To apply the same register settings on all the devices, select the All Devices check box. In this mode, if 

the settings for any of the sensors are changed then the setting for all other sensors are also changed. 

For example, clicking Apply for sensor 2, after making changes to sensor 2, will apply the changes to all the sensors. 

Clicking Apply for any of the other sensors will update all the sensors to the settings of that sensor, not the changed 

settings of sensor 2.  

This does not apply to the master/slave bit, as only one sensor can be the master. Single device mode must be used to 

change the master to a different device. 

                 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 14: Single Devices and All Devices programming modes 

If one of the configuration cogs is clicked while All Devices mode is active, Single Device programming mode is set 

automatically. Apply changes to the configuration form (see page 8) as required. To apply these changes to all sensors, 

select All Devices and then click the Apply button for the sensor. 

3.5 Saving and Loading Settings 

Click on the Save button to save the current settings for all sensors. To restore settings saved previously, click on the 

Load button, and then browse to the required file.  
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4 Single 2x2 pixel view 
When the software starts, it displays a set of registers for each connected device (up to four). With a 2x2 array sensor 

(a single device incorporating 4 pixels) connected, the Sensor Evaluation Tool initially displays only one set of registers, 

the same as when one single pixel device is connected.  

To display registers for each channel in the array, select Single 2x2 Array Sensor View from the View menu. 

 

 

 

 

 

In Multiple Single-Pixel Sensors View, the pixel is always attached to channel 2. In Single 2x2 Array Sensor View, 

however, the text above each scope states which channel is being displayed.  

In this view, the available programming modes are Single Channel or All Channels. With Single Channel selected, the 

register boxes for channels 2, 3 and 4 are active allowing each channel’s settings to be changed independently of the 

others. 

 

 

Figure 15: Single 2x2 Array Sensor View 

Figure 16:  Single 2x2 Array Sensor View in Single Channel programming mode 
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With All Channels selected, the register boxes for channels 2, 3 and 4 are greyed and disabled with the settings from 

Channel 1 applying to all channels. Click on the Apply button to confirm any changes to the register settings. 

Figure 17: Single 2x2 Sensor View - All Channels programming mode 
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4.1 Register Control Settings 

Click on the ‘cog’ adjacent to the CCP Register settings to display the Register Control dialog box. If All Channels mode 

was enabled, Single Channel programming mode is disabled, and the registers can now be programmed 

independently. In Single Channel programming mode, only Channel 2 settings are displayed, and these apply to all four 

sensors. 

Figure 18: Single 2x2 Sensor View - CCP Register Control dialog box 
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5 Expert View 
For a more detailed view of the sensor and additional options select Expert View from the View menu.  

 

 

 

 

 

Figure 19: Opening Expert View 

 

Figure 20: Expert View 

Use Expert View to put the device into Sleep Mode, edit the scopes and assign device channels to them, and to control 

an emitter, if one is connected. The emitter controls are always displayed even if no emitter board is connected (there 

is no feedback from the board for the software to ascertain if a connection is present). 

There are two tabs: Scope Settings and ezPyroTM Devices. 

5.1 Sleep Mode 

Use the ezPyroTM Evaluation Tool to put a device into Sleep Mode. However, the software does not allow the device 

to subsequently be forced to wake up. It is therefore important that the Sleep Mode WUP registers are manually set 

to values that allow a wake-up condition to be met before the device is put into Sleep Mode. Please refer to the sensor 

reference manual for details. 

To put a device into Sleep Mode, click on the Go To Sleep button. 
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5.2 Wake Up Settings 

For valid wake up settings, the UHT and ULT cannot be set to the same value, the LHT and LLT cannot be set to the 

same value, and the thresholds cannot be set to the maximum and minimum values. The WUT threshold must be set 

to at least the minimum number of samples. 

 

Figure 21: Valid LHT, LLT, UHT and ULT settings 

If these conditions are not met, the following warning message is displayed. 

 

 

 

 

 

Figure 22: Wake up settings warning message 
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5.3 Scope Settings 

Use the Chart Control settings to configure the X and Y scales and grid spacing on the four scopes. Select the channels 

to be displayed by the four scopes using the Scope 1, Scope 2, Scope 3, and Scope 4 dropdown boxes. 

 

Figure 23: Scope Settings showing the dropdown device list for Scope 1 

5.4 Sensor Devices 

This tab shows the Emitter Control settings. The graphic on the right-hand side shows which of the devices is currently 

active and editable on the tab. The active registers are shown in green. Click on another device (for example, U4) to 

update the tab with that device’s register settings.  

 

 

 

 

 

 

 

 

 

Figure 24: ezPyroTM Devices tab in Single Device programming mode with U1 (left) and U4 (right) settings selected 

By selecting the All Devices programming mode, all the sensor graphics are coloured green and the text boxes display 

the last individually selected device. 
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Figure 25: ezPyroTM Devices tab – All Devices programming mode 

5.5 Register Control in Expert View 

 

 

 

 

 

 

 

Figure 26: CCP Register- Detailed View 

In Expert View, the Register Control dialog boxes (displayed by clicking on the ‘cog’ buttons) display descriptions of the 

registers in the same way, except for the CCP Register. This is because the single-pixel sensor view is designed for 

sensors with a single-pixel. Therefore, most of the CCP registers are not required. However, in Expert View no 

assumption is made about pixel numbers and the additional registers are displayed. 

 



ezPyroTM Evaluation Tool Software User Manual   

 

Page 19 of 25 © Copyright Pyreos Ltd. 2020 ezPyroTM User Manual Rev. 1.10 

 

6 Saving Data to CSV file 
To save data, select Save to CSV from the File menu.  

 

 

 

 

Figure 27: Save to CSV 

The Capture Data to CSV File dialog box is displayed.  

 

 

 

 

 

Figure 28: Save to CSV clicked 

Enter the full address path to which the file should be written or browse to the required folder. By default, files are 

saved to the Pyreos folder if it exists or Documents if it does not. The Pyreos folder is created automatically in the 

Documents folder the first time the user saves a configuration file. 

Choose options for the way data is to be captured. The options are to: 

 Capture data indefinitely: save data until Stop CSV Capture is selected from the File menu. 

 Number of Samples to capture: save a specific number of samples according to the sampling rate set in CSV File 

Options. 

 Capture time xxxx ms: record data for a set time interval (in milliseconds). 

6.1 Data Sampling Rates 

1. Choose CSV File Options from the File menu to set the timing interval for data sampling. 

 

 

 

 

 

 

 

 

 

Figure 29: CSV Options Clicked 
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2. Select the Use Timing Options checkbox. 

 

 

 

 

 

Figure 30: Enabling CSV Options 

3. Input values for: 

 Time period between data records: the delay between consecutive data samples 

 Time duration per record (Seconds): the time of each record.  

WARNING: The duration of each record cannot be greater than or equal to the delay between consecutive records. 

  

  

  

 

 

  

Figure 31: Applying data sampling times 

4. Click on the Apply button. 

Invalid timing options result in a warning message being displayed. If this occurs, correct the settings, and reapply. 

 

 

 

 

Figure 32: CSV Options error message 
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7 Saving and Loading Configuration Files 
There are two options for saving the current settings in configuration files: 

 Save: create and save the configuration in a text file in any location (Documents\Pyreos if unspecified). 

 Save Default: as above, but also create or overwrite the default configuration file applied whenever the 

software initially connects to a device. This file has the name “default.txt’ and is located in the 

Documents\Pyreos\ezPyro Evaluation Tool folder. 

7.1 Saving Settings 

To save the current set of register settings for future use:  

1. Click on the Save button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 33: Save and Load buttons 

2. A Save As dialog box is displayed. By default, files are saved in a folder called Pyreos in the Documents folder. 

 

 

 

 

 

Figure 34: Saving Settings 

3. Enter a suitable file name for the settings. The settings file is saved as a text file (TXT extension). 

4. Click on the Save button. 
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7.2 Saving the Default Configuration 

Click on the Save Default button to update the default configuration used by the software. You are given the option 

to save the configuration under another filename as described in the previous section. When confirmed, a second 

version of the configuration is saved as “default.txt’ in the Documents\Pyreos\ezPyro Evaluation Tool folder. If the file 

already exists, it is overwritten. The default configuration file is applied to a device whenever the software first 

connects to it.  

7.3 Loading Settings 

To apply a previously saved set of registry settings: 

1. Click on the Load button 

2. An Open dialog box is displayed. 

 

Figure 35: Load Settings - Select File 

3. Select the required settings file. 

4. Click on the Open button. The register settings are applied to the currently active device(s).  

Note: Configuration files are specific for the number of devices used: for example, a configuration file for 2 sensors 

will not work for 1, 3 or 4 sensors. 
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8 About 
Click on About in the menu bar to display file and version information about the ezPyro Evaluation Tool software. 

 

 

 

 

 

 

 

Figure 36: About Dialogue Box 

9 Troubleshooting 

9.1 No Kit Detected on the COM Ports 

If no kit is detected on the COM port –  

 Try rescanning the ports using the Rescan Ports options in the Devices dropdown menu. 

 Try disconnecting the USB cable from the device and the PC and then reconnecting everything. 

 Try disconnecting the USB cable from the device and the PC, close the Pyreos software. Reconnect the 

USB cable to the device and the PC and reopen the Pyreos software. 

9.2 Signal Saturation 

9.2.1 Continuous Saturation 

If the signal remains saturated use the CCP and AFE register cogs to alter the gain, high pass filter, low pass filter, 

sample rate, and feedback trans. to the required levels so that the system gives clear, stable readings 

9.2.2 Sporadic Saturation 

If the readings are stable but suddenly saturate and then stabilise again, ensure that the environment around the kit 

is stable. Limit changes in temperature caused by air flow; drafts, air conditioning, etc. and sunlight. 

9.3 I/O Exception 

 

 

 

 

 

 

 Figure 37: I/O Exception 
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If this warning appears check that the USB cable is undamaged and that it is connected properly.  

A timeout warning also appears and the kit needs to be reconnected in the usual manner. 

 

 

 

 

 

If the problem persists replace the USB cable, ensuring that it can handle the transfer of both power and data. 

9.4 Known ‘Save To CSV’ Bug  

There is known bug when saving data from the ezPyro Evaluation Tool software. 

The browse function allows the user to create a file in a specified folder.  

 

 

 

 

 

 

 

However when ok is clicked the following exception appears. 

 

 

 

 

 

 

 

 

 

 

 

At present the work around is to enter the file name directly in to the dialogue box. To save as a CSV file add .csv at 

the end of the file name, if this is omitted then the file is saved as a FILE and has to be converted to .csv later. 

Figure 38: Timeout warning 

Figure 40: Directory Not Found Exception 

Figure 39: Browsed path to save csv file 
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This saves the file to the Pyreos\ezPyro Evaluation Tool folder that is automatically created in the Documents folder of 

the connected PC as part of the ‘Save to CSV’ process. 

10 Further Information and Support 

The Pyreos website has a list resources available to help our customers  

https://pyreos.com/resource-centre 

If you encounter any difficulties with the kit, please contact Pyreos Support 

E-mail: support@pyreos.com 

11 List of Abbreviations 
 

AFE Analog Front End 

CCP Channel Control Packet 

CSV Comma Separated Values 

HPF High Pass Filter 

LHT Lower High Threshold  

LLT Lower Low Threshold 

LPF Low Pass Filter 

WT Wake-up Time Threshold 

WUP Wake-Up Packet 

UHT Upper High Threshold 

ULT Upper Low Threshold 

 

Figure 41: Direct save to csv file naming 
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